
NSF BioPACIFIC MIP

Analytical HPLC Manual

For training and further questions contact

Zach Nett: zjnett@ucsb.edu

Last Updated October 16, 2024



Contents

1 System Overview 2

2 Check the waste container 2

3 Power on the instrument 2

4 Solvent management 4

4.1 Solvent preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

4.2 Solvent and additive exchange . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

5 Analytical sample preparation 6

6 Create an analytical method 8

6.1 Pump tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

6.2 MS tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

6.3 Data Acquisition tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

6.4 Interface tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

6.5 PDA tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

6.6 Column Oven tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

6.7 Autosampler tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

6.8 AutoPurge tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

6.9 Download and Save the method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

7 Run an analytical sample 15

7.1 Start a new batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

7.2 Modifying a running batch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

7.3 Manual Shutdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

8 Analyzing the data 18

8.1 Postrun program for analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

8.1.1 Viewing operation tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

i



8.1.2 View MS chromatogram and spectra . . . . . . . . . . . . . . . . . . . . . . . 19

8.1.3 View the PDA data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

8.1.4 Modify the integration parameters . . . . . . . . . . . . . . . . . . . . . . . . 23

8.1.5 Export the data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

8.2 Data Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

8.2.1 Comparing multiple files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

8.2.2 Overlay PDA and MS data . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

8.2.3 Layout Templates for comparing multiple files . . . . . . . . . . . . . . . . . . 26

1



1 System Overview

The Shimadzu Nexera analytical HPLC system within the NSF BioPACIFIC MIP facilitates the
identification and quantification of complex mixtures while also supporting method development
for their purification on preparative and semi-preparative scales. The system is equipped with
a 6-way switch valve, allowing for automated switching between 4 columns with distinct surface
chemistry and retention properties. The column selection is controlled by the programmed method.
The schematic below illustrates the overall system layout.

The analytical pump is a quaternary pump that uses four different solvents located in 1
L bottles on top of the instrument. There is a 180 µL mixer located within the pump module
that blends the fluids. Analytical samples are introduced by the autosampler, separated by one of
four analytical columns, and subsequently analyzed by a dedicated PDA and the LCMS-2050 MS
detector.

In general, running the HPLC involves six key steps:
1. Start the software and prepare the instrument.
2. Design a method specific to the analysis requirements.
3. Prepare the sample for injection.
4. Configure and execute a batch run.
5. Clean the columns and shut down the instrument after use.
6. Analyze the obtained data and export as needed.

These steps, along with other important aspects like solvent and waste management, will be further
explained in the subsequent sections.

2 Check the waste container

Before starting a run, it is essential to check the capacity in the receiving waste container. If the
waste container is full, it should be transferred to the designated hazardous waste pick-up area,
ensuring that the waste label is correctly marked. Subsequently, a new waste container, typically
an empty 4 L solvent bottle, should be installed, accompanied by a fresh hazardous waste label.

3 Power on the instrument

Each user will clean the columns that were used in their method and shutdown the instrument
before leaving. When approaching the HPLC, it will be in a sleep state and look as such:
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Double-click the Lab solutions icon on the computer desktop to open the software.
Login user ID is “Admin”. No password is required. Click OK.

Start the analytical real-time analysis program by double-clicking the icon listed under
Instruments. An audible beep will be heard as the system connects to the computer.

When the icon is double-clicked, the analytical HPLC software will open to the following

screen. Click and to ready the instrument. It will take about ten minutes
for the Desolvation Temperature to reach its operating temperature of 450 °C, at which point the
MS will be ready to use. To efficiently use this time, begin to set-up a method or prepare your
samples. If present, the warning will resolve when a batch of samples is started
using the batch template and autopurge function, as described in section 7.1.
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4 Solvent management

A solvent manager system monitors the solvent level gravimetrically by the weight of the bottles
sitting on top of the LC system. A warning will be given when the level within one bottle falls
below 300 mL, and the system will shut down entirely when approximately 100 mL of that solvent
remains in order to protect the columns.

4.1 Solvent preparation

Dedicated bottles of solvent employing TFA or formic acid as an additive are available for use.
Before starting a run, ensure that adequate solvent is installed on top of the system and that the
additives it contains are appropriate for your experiment. If more solvent is needed, this section
provides instructions on how to prepare additional solvent containing 0.1% additives (formic acid
or TFA) as required. LCMS grade formic acid is stored in the refrigerator, while LCMS grade TFA
can be found in the same tub as the prep solvents on the floor. For transferring TFA or formic
acid, utilize a disposable 1 mL syringe, as illustrated below:
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To prepare additional analytical solvent, follow these steps:
1. Ensure the pump is turned off.
2. Remove the bottle to be exchanged or refilled, allowing the tubing and filter attachment

to hang gently off the front side of the instrument (refer to the accompanying photos for
reference).

3. Take a cap, seal the bottle selected for use, and place it on the large platform balance for
taring.

4. LCMS grade solvent is stored in the blue and yellow flammable cabinet. If an open 4 L
bottle is available, use it to fill the 1 L HPLC bottle with the desired solvent (e.g., water or
acetonitrile) in a fume hood. If a new bottle must be opened, please label it appropriately.

5. Reseal the 1 L bottle and determine the mass of the added solvent.
6. For a 0.1% solution in water, divide the measured mass by 1000 to calculate the volume (in

mL) of TFA (or formic acid) that should be added to the bottle. For a 0.1% solution in
acetonitrile, divide the measured mass by 786 to calculate the milliliters of TFA (or formic
acid) that should be added to the acetonitrile bottle.

7. If this bottle is the same composition as that which was removed, immediately re-install the
bottle on top of the instrument. Otherwise, proceed to the next section to manually purge
the pump while installing the new bottle.

4.2 Solvent and additive exchange

It is recommended to perform a manual purge of the analytical pump when switching between
solvents containing formic acid, TFA, or other volatile additives. It is important to note that non-
volatile additives such as phosphates or other salts should never be used on this system, as they
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will damage the MS.
To purge the solvent lines, follow these steps:

1. Open the door of the analytical pump.
2. Turn the handle of the black valve counterclockwise to open the purge valve.

3. Press the purge button, type the number of the solvent line you would like to purge (e.g., 1
= Solvent A, 2 = Solvent B, 3 = Solvent C, 4 = Solvent D), and press Enter.

4. Install the new bottle of solvent on top of the system while the purge is in progress. This
ensures that the new bottle remains uncontaminated by any remnants of the previous solvent
in the lines.

5. Monitor the progression of air bubbles introduced during the transfer of the inlet tubing to
the new bottle. Wait until all air bubbles have been eliminated after passing through the
purge valve exit.

6. Repeat for each additional solvent line as needed. Once the purging is complete, remember
to close the black valve finger-tight. Do not close too tightly as it may cause damage to the
pump.

5 Analytical sample preparation

Always filter samples using the provided disposable 0.45 µm syringe filters. Both
hydrophilic PVDF and hydrophobic PTFE membrane materials are suitable for filtering aqueous
solutions, but sometimes more hydrophobic samples (peptoids/peptides) can adsorb to the PTFE
surface when poorly solvated in water; in which case, the PVDF membranes are recommended.
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Vials of the mobile phase solvents with additives are provided near the instrument to prepare
samples for injection. Samples should be dissolved in 100% aqueous solution. If the sample is
insoluble in 100% water, add organic modifier (acetonitrile), but keep it to a minimum to prevent
premature elution of the sample from the column.

Sample concentrations of 0.001 to 0.01 mg/mL are generally adequate for injection volumes
of 10–20 µL. However, ∼0.1 mg/mL has been necessary for large peptides/peptoids (>50-mer).
If you are not obtaining enough signal from your sample at a given concentration, you can opt
to increase the injection volume up to 100 µL. As a rough guideline, the max sample capacity
for a 4.6 mm diameter analytical column is 0.1–0.2 mg. However, it’s important to note that the
exact load capacity can vary depending on the nature of the sample and the specific separation
conditions being used. Avoid overloading. Too much sample should not be injected. If peak
shape changes by diluting the sample 10-fold or by decreasing the injection volume to one fifth,
there is a possibility of sample overloading.

Overloading is also indicated by the fronting of peaks as illustrated:

Open the autosampler tray and place the prepared samples inside, noting the tray number
and labelled position number within the tray.
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6 Create an analytical method

Navigate to File → New Method File. Select Analytical Template to start developing a new
analytical method. This template applies a 5-95% gradient of B (acetonitrile) over 45 min with a
3 min hold to flush the column and 2 min hold to re-stabilize at the initial condition.

The Method Editor window will appear, containing a series of tabs that represent different
modules of the HPLC. It is recommended to modify the tabs in the order presented. Some tabs
may not require modification.

6.1 Pump tab

The pump tab defines the gradient that will be applied during the sample run. When the tab is
selected, it by default shows settings for pump LPGE, which refers to the quarternary analytical
pump.

Analytical flow rates should be within the range of 0.5–1.2 mL/min. A gradient steepness of 0.5–
2.0 % acetonitrile/min is recommended for peptides and peptoids. Time to reach flow protects the
columns from rapid changes in pressure and should be set to 1 min. Under the gradient menu, a
simple gradient from 5–95%B can be programmed for the method using the graphical entry on the
right shown below. Always include an isocratic hold for 3 min at 95 %B at the end of the gradient
to clean the column for the next run.
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Gradients of greater complexity can be defined via Advanced gradient mode. An example of
the above gradient in tabular form is shown below:

Use of the table format is advantageous for reducing the overall run time by applying gradients
within a narrower range of interest. However, it is important to note that a subsequent isocratic
hold at 95% B is always necessary at the end of the run to clean the columns. To ensure the column
returns to its initial condition, a 2-minute hold at 5% B is included. An example of an advanced
gradient table, which incorporates a reduced LC Stop time, a narrower eluent composition range
of 5-50% B, and isocratic holds, is provided below:
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6.2 MS tab

Important: Only use positive mode for solvents containing TFA or damage to the MS detector may
occur. If you would like to use negative mode, ask for assistance in switching the system to an
appropriate solvent and additive.

Ensure that the cycle time is set to 0.5 seconds in the MS tab. The data acquisition end
time in the SCAN event table determines the duration over which the MS detector scans the m/z
range and records data to generate a chromatogram of the total ion current. The acquisition time
should be equal to the total run time, including any isocratic holds. Please note that the ”Apply
to All acquisition time” icon in the Data Acquisition tab (see section 6.3) no longer applies the LC
Stop Time to the MS tab. Therefore, it is crucial to check that the end time in the event table
corresponds to the stop time set in the Pump tab.
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The entire m/z range for scanning is 10 to 2000. It is possible to acquire full m/z scans in
both positive and negative modes simultaneously, except when TFA is used as the eluent additive.
To enable negative mode, click on “Add Event” and modify the event settings to select a negative
polarity and the full m/z range, as shown in the example below:

To delete an event, right-click on the entry in the event table, and select “Delete Event”.
If the analyte m/z is known, narrowing the mass range can increase instrument sensitivity.

Alternatively, selective ion monitoring (SIM) can be used to enhance the sensitivity and selectivity
of the analysis by focusing on specific ions of interest. In SIM mode, the mass spectrometer monitors
and records the signal intensities of predetermined ions or m/z values of interest, disregarding other
ions present in the sample. This targeted approach improves the signal-to-noise ratio and increases
sensitivity for the desired analytes. However, it is important to note that compounds can possess
multiple charges, and it is possible that the more charged compound may exhibit higher relative
abundance.

To incorporate a SIM event, navigate to the SIM tab and make sure the “m/z input” box is
selected. Then, click on ”Add Event” to create a new event. Choose the polarity for monitoring
and use the downward arrow to modify the entries in the highlighted m/z field, which is displayed
in red.
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A pop-up window will appear to set the m/z values for the target analyte, as in the example
shown below. Click OK to save the entries.

6.3 Data Acquisition tab

The data acquisition tab tells the detectors to acquire data for the duration of the run and to set
the frequency of measurement for the analytical PDA detector. The LC Stop Time should equal
the entire run time. As an example, for a 5-50% gradient applied over 25 min, LC Stop time should
equal 30 min, since it includes time for cleaning and stabilization of the column.
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Click Apply to All acquisition time. It is not recommended to adjust the sampling rates
for the PDA in order to avoid data files becoming too large or the data being too sparse.

6.4 Interface tab

For the Interface tab, confirm that the drying gas is enabled as shown below.

6.5 PDA tab

The PDA is the analytical UV-Vis detector that is capable of monitoring all wavelengths (190–800
nm) simultaneously. The example below shortens the range of interest to 190–400 nm to reduce
the file size and employs the deuterium (D2) lamp only. The tungsten (W) lamp or the D2 & W
lamps can be used to monitor wavelengths of 371–800 nm or 190–800 nm, respectively.
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6.6 Column Oven tab

Set the desired column temperature, bearing in mind that the maximum allowed temperature is 60
°C. Select the appropriate analytical column (1, 2, 3 or 4) for both valves. The column designations
are as follows:

1. XBridge BEH C18 Column, 130Å, 5 μm, (4.6 mm x 150 mm)
2. XBridge BEH C18 Column, 300Å, 5 μm, (4.6 mm x 150 mm)
3. XBridge Protein BEH C4 Column, 300Å, 3.5 μm, (4.6 mm x 100 mm)
4. SeQuant ZIC-pHILIC Polymeric Column, 100Å, 5 μm, (4.6 mm x 150 mm)

For reverse-phase chromatography of small molecules and peptides/peptoids with fewer than
15 repeat units, Column 1 is recommended. Column 2 is more suitable for larger peptoids/peptides,
while Column 3 is designed for highly hydrophobic materials with excessively long retention times
on Column 2.

Note use of methanol in lieu of acetonitrile may increase the retention time of more hydrophilic
peptoids/peptides. However, keep an eye on the increase in back-pressure when using methanol
and use this solvent sparingly.

Column 4 is dedicated to HILIC (Hydrophilic Interaction Liquid Chromatography) chro-
matography, a technique suitable for polar and hydrophilic compounds that are challenging to
retain and separate using traditional reversed-phase media. Suitable buffers for HILIC include
ammonium acetate, ammonium formate, formic acid, and acetic acid, with a concentration range
of 5-20 mM being sufficient for most solutes. For example, a typical gradient elution profile for the
ZIC-pHILIC column is a linear gradient from 90–40% acetonitrile at a flow rate of 0.5 mL/min with
a 10 min of pre-equilibration at the starting condition. The fraction of water in the eluent should
not be varied outside the range of 3-60%, and the columns should never be operated at 100% water
or organic. Due to the unique requirements of HILIC chromatography, it is strongly recommended
to consult with BioPACIFIC MIP staff before attempting to use Column 4.

6.7 Autosampler tab

No adjustments are necessary for the settings on the Autosampler tab, which should be displayed
as shown below:
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6.8 AutoPurge tab

Make sure to enable the pump purge and autosampler purge options, as depicted below:

6.9 Download and Save the method

Once all the method tabs have been reviewed, click to download the method to the
system and exit the Method Editor. Save the method to your data folder by navigating to File →
Save Method File As...

Create or locate your folder in the C:\LabSolutions\Data directory and name the method file
such that the method is well-described. The filename “analytical 5-95ACN 45min col1.lcm” has a
good naming structure because it indicates an analytical method employing a 5–95% gradient of
acetonitrile over 45 min using column 1.

7 Run an analytical sample

7.1 Start a new batch

To run a sample, select ”Real-time Batch” from the main menu (refer to the image below).
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Create a new batch file, by clicking File → New Batch File. Select Analytical Batch Tem-
plate. The template includes two line entries for samples and three lines for shutdown methods
corresponding to each reverse-phase column. Additional line entries can be added by inserting
rows above the shutdown methods. Right-click on a line entry, select “Insert Row” to add a new
row above. The shutdown methods automate flushing each column with acetonitrile so that the
column is stored without TFA (or formic acid) after use. Delete shutdown method entries for
unused columns. It’s important to note that using the position vial# -1 in the shutdown methods
will result in no injection, effectively allowing for the running of a ”blank” without occupying a
physical vial position on the sample tray.

The method template includes an AutoPurge option for the first sample run, which auto-
matically purges the autosampler and pump. The Autopurge option should not be selected for
subsequent runs.

Specify the tray and vial numbers for the samples in the analytical autosampler. The sample
name will be used as the filename for the data.

A typical starting injection volume is 10 µL, but it can be adjusted from 1–100 µL as needed.
If no signal is observed from the analyte, increase the injection volume. Conversely, if the column
is overloaded, decrease the injection volume. Ensure that the directory of the method matches the
method file created earlier or the desired method to be used.

The example batch below shows how one can run two different samples (located in positions
tray 1, vials 3 and 4). The first sample will be ran twice using two different methods - one specific
for column 1 and one specific for column 2. The second sample is run also using the method
developed for column 2. Because only columns 1 and 2 are used, the shutdown method entry for
column 3 is deleted. To insert, add, or delete a row, right-click on the line entry and select the
corresponding option.
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To start the batch, highlight all rows, and click the green play button . Save the batch file
in your folder using an informative filename such as the date. The system will proceed to purge
the solvents and autosampler, run the samples, clean the columns, and automatically shutdown at
the end of the batch.

Data can be monitored in real-time using the PDA, MS, or All viewing windows (see below).
The LC tab shows changes in pressure of the analytical pump and can be useful for distinguishing
whether PDA signal changes are attributable to the presence of sample or some fluctuation in
pressure.

7.2 Modifying a running batch

A running batch can be paused to edit the Batch Table. To pause a batch, click the (Edit
table/Restart) icon. Set the row where the batch should pause and click OK.

Data acquisition will stop at the selected row. Add, insert, or delete entries in the batch
table by right-clicking on the row and selecting the row action. Do not delete entries that
have already run. Click the save button on the toolbar. Remember to click the (Edit
table/Restart) icon to resume the batch.

7.3 Manual Shutdown

The instrument will shutdown automatically after a batch is completed. However, if the instrument
needs to be shutdown manually, simply close the realtime analysis software window to exit the
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software. A shutdown prompt will appear. Check the boxes as shown below and click OK.

8 Analyzing the data

Quantitation uses chromatographic data to determine the amount of a given component in a mix-
ture. There are several types of quantitation methods commonly used. This section covers the very
basics of data analysis, utilizing peak area percent obtained from an integrated PDA chromatogram
as a rough estimate of the relative amounts of analytes present. This method assumes that the
wavelength absorbance properties of all compounds observed are equivalent, which is likely not a
valid assumption. The MS data is used only for mass confirmation of the observed analyte.

Other more in depth methods of quantitation require the use of internal and external stan-
dards and are not commonly employed in the routine analysis of newly synthesized materials. For
more information on these types of analyses, refer to the manufacture manual entitled “Operators
Guide (LCMS Edition)”.

8.1 Postrun program for analysis

Select “Postrun” from the LabSolutions Main window.

Drag-and-drop a data file onto the Data analysis window from the Data Explorer sub-window.
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8.1.1 Viewing operation tips

8.1.2 View MS chromatogram and spectra

For analyzing MS data, click [MS Data Analysis] under the [Main] window.

To generate a spectrum, double-click the time point in the chromatogram. Click the arrows
for “peak” or “scan” to move the spectrum extraction line to the next peak time or by the next
preset scan unit.
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Double-click the m/z in [spectrum view] to extract as a chromatogram. The chromatogram
of that m/z is added to the [Chromatogram View].

Alternatively, to add extracted chromatograms of other m/z values to the chromatogram
display, edit the MS Data view parameters sub-window under the MS Data tab as shown.
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To average MS spectra over a specified time span:

The spectrum display can be improved by subtracting the background MS spectrum from the
averaged spectrum:
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8.1.3 View the PDA data

To view the analytical PDA in post-run, click “PDA data analysis” icon located under
the main sub-menu on the left. The data should appear in a simplified form showing only the
chromatogram view, peak table, and method view. If there are more windows shown, under the
Layout menu, select the PDA layout, or drag the frame borders so that only these windows are
shown for simplicity.
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Select the button to modify the Chromatogram, and then return to mode to reflect
any changes. While in edit mode, under the “Multi Chrom” tab, change the Ch1 wavelength of
absorbance to the wavelength of interest (e.g., 214 nm for peptoids and peptides).

8.1.4 Modify the integration parameters

In edit mode, under the integration tab, select the channel of interest. If necessary, reduce the
number of peaks included due to noise in the data by increasing the [Slope] or [Min. Area/Height]
by a factor of 10.

To prevent integration of extraneous peaks at early or late times in the run, click , and
fill-out the table to turn off integration for specific regions:
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These steps are generally sufficient for processing. Press the help button to learn more about
peak integration commands if desired.

8.1.5 Export the data

To export the peak tables, chromatograms (PDA and UV), MS Chromatogram TIC, and MS
Spectrum, go to File → Export Data → Export Data (ASCII Conversion). Select the
Output file option and check the boxes for the desired output options (peak table, chromatogram,
etc.) to save the data as a tab-delimited .txt.

No MS spectrum will be exported if it has not been registered. To register a spectrum click

“register spectrum to process table” icon located in the top menu bar.

8.2 Data Browser

Open Data Browser to display chromatograms and spectra from multiple data files for comparison
or to overlay data from different detectors.
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8.2.1 Comparing multiple files

Within Data Browser, data files are opened by drag-and-drop from the data explorer window
to the display cells on the right. To change the type of data displayed in each cell, right-click the
cell and select “Change data type”.

Use the layout property icon to change the row x column arrangement of cells. To add

a row or column to an existing layout, use the icons on the top panel.
Cells are linked by their cell number shown in the upper right-hand-corner of each cell. For

example, cells labeled with “1” will correspond to the same opened file, and cells labeled “2” will
correspond to a second open file. Click on the cell number to change it. Drag-and-drop files to the
different sets of cell numbers to view multiple files simultaneously.

8.2.2 Overlay PDA and MS data

This section describes how to use a layout template to overlay PDA and MS data for a single
analytical data file:

1. Go to the menu Layout → Open Layout File.

2. Select the layout Analytical.lyt from the Browser Layout Templates folder located on the
Desktop. Drag and drop a file from the data explorer window to the display cells on the right.

3. Click the Data Processing Parameters icon in the data browser menu.

4. On the “Multi Chrom” tab, enter the absorbance wavelength of interest and uncheck “Display
Extracted Chromatogram”. Click OK.

5. Double-clicking within the PDA chromatogram will generate the mass spectrum for that time

point. MS spectra can also be averaged or background subtracted using the same icons
described in section 8.1.2.
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6. The auto-integration parameters can be adjusted (if not previously performed and saved in
post-run analysis), in the Integration tab of the Data Processing parameters window.

7. To overlay the PDA and MS data within the same window. Right-click on the MS chro-
matogram and open “Display settings”. Navigate to the “LC Settings” tab and check the
Disp. box. Click OK. The MS and PDA chromatograms are overlaid.

8.2.3 Layout Templates for comparing multiple files

Three additional layout templates have been pre-configured to assist in comparing of multiple data
files:

1. Analytical Comparison.lyt compares the chromatograms and spectra of two analytical
data files.

2. Prep Comparison.lyt compares the chromatograms and spectra two prep data files.

3. Analytical Prep.lyt compares the chromatograms and spectra of one analytical and one
prep data file.

Click on the menu Layout → Open Layout File. Select the layout from the Browser Layout
Templates folder located on the Desktop. Drag and drop files from the data explorer window to
separate cell windows labeled “1” and “2”.
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